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ABSTRACT

Pinnacle 21 software is widely used by the industry for helping prepare data in a standardized format that
is required for regulatory submissions. Pinnacle 21 Command Line Interface (CLI) allows automation of
validation jobs resulting in higher reliability of results and better overall performance of data preparation
process. This presentation will review new capabilities and syntax of the recently updated version of
Pinnacle 21 CLI and provide examples for automating validation using SAS® programming language.

INTRODUCTION

Pinnacle 21 Validator can be run either from a graphical user interface (GUI) or command line interface
(CLI). Both options support the full set of validation features but are designed for different use cases.
Where GUI is most commonly used for ad-hoc validation, the CLI is typically utilized for process
automation and customization. Because the CLI can be called directly from SAS, it eliminates the need
for the SAS programmer to exit the programming environment to run Pinnacle 21. The CLI can be kicked
off periodically or when new data has been placed in a specific location or simply appended to the end of
a SAS program as a QC step. Moreover, the SAS code used to call the CLI can be incorporated into a
SAS macro or batch file and used over and over again for multiple studies across your organization,
ensuing consistency in the validation process wherever appropriate. The CLI also offers greater power
over the validation process, giving the user control over items such as validation report name and output
location.

To download the newest Pinnacle 21 client, visit https://www.pinnacle21.com/downloads and to learn
more about the CLI, go to https://www.pinnacle21.com/documentation.

CLI PARAMETERS AND SYNTAX

The CLI has long been a feature of Pinnacle 21 products and the latest software release includes new
syntax and more options. The most used parameters for all users are depicted in Table 1 and a full list
can be found by running the following code from the command line:

java -jar -p2l-client-{version}.jar -help
NOTABLE CHANGES

The new CLlI is called from p21-client-{version}.jar unlike prior releases which used task-
specific files: validator-cli-{version}.jar, data-converter-{version}.jar, define-
generator-{version}.jar. Additional changes include the following:

e  Support for validation of define.xml file has been added

e The syntax has been changed from -parameter=value to --parameter=value

e The report:overwrite parameter has been decommissioned and all reports will overwrite an
existing report with the same name by default

e The config parameter is no longer required for validation and instead the user may elect to
specify standard and standard.version; however, the parameter is still available for use
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Parameter Valid Values Default Description
Standard and Version
SDTM
SEND
--standard ADaM
--standard.version <version> Version of standard.
Validator Source Data
--source.adam <File List or Path> Path to source ADaM data files. Can

contain directories or individual files
separated by semicolon.

--source.sdtm <File List or Path> Path to source SDTM data files. Can
contain directories or individual files
separated by semicolon.

--source.send <File List or Path> Path to source SEND data files. Can
contain directories or individual files
separated by semicolon.

--source.define <File> Path to define file.

Validator - Terminology

Version of ADaM controlled

--cdisc.ct.adam.version <version> <latest> terminology.

--cdisc.ct.sdtm.version <version> <latest> ?/e?::;gglg;yS.DTM CDISC controlled

--cdisc.ct.send.version <version> <latest> Y:J:;g&g;ys_END CDISC controlled

--meddra.version <version> <latest> Version of MedDRA dictionary.

--ndf-rt.version <version> <latest> Version of NDF-RT dictionary.

--snomed.version <version> <latest> Version of SNOMED dictionary.

--unii.version <version> <latest> Version of UNII dictionary.

--whodrug.version <version> <latest> Version of WHODrug dictionary.
Validator - Report

--report <File or Path> File or path to Excel specification. If

Path is provided, CLI will use default file
name [pinnacle21-report-yyyy- MM-
ddTHH-mm.xlIsx] --report parameter is
required for data validation.

--report.cutoff <#> 1000 Number of times a record detail is
printed per issue. For no limit specify 0.

Define.xml Designer - Convert Excel to Define.xml

--source <File or Path>

Either --report or --output parameter is

--output <File or Path> .
required.

Table 1. List of Commonly Used CLI Parameters

CALLING THE CLI FROM SAS

The latest CLI is a robust tool and can easily be integrated into SAS programs. In the following examples,
the core features of the CLI are depicted by calling the CLI using the X statement in SAS. Let’s start by
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assigning some key pieces of information to macro variables so we can reference them later:

/* Pinnacle 21 Parameters */
/* Note: the configuration file folder should be in the same location as p2l-
client-{version}.Jjar */

%let jarpath = C:\Users\p2l-client ;
%let jarfile p2l-client-1.0.7.jar ;
%let configpath = C:\Users\p2l-client\config ;

/* CDISC Data Parameters */

%let sdtmpath C:\Users\study-101\sdtm\xpt ;

%let adampath = C:\Users\study-101\adam\xpt ;

%let sdmtdefine C:\Users\study-101\sdtm\Define ;
%let adamdefine C:\Users\study-101\adam\Define ;

e

/* Validation Report Parameters */
$let reportpath = C:\p2l-client\reports;

Example 1. SDTM Validation

X
java -jar "&jarpath.\&jarfile."
--standard=sdtm *
--standard.version=3.2
--source.sdtm="&sdtmpath."
--source.define="&sdmtdefine."
--cdisc.ct.sdtm.version=2017-12-22 »
--unii.version=2017-11-15 *
--ndf-rt.version=2018-02-05 *
--meddra.version=19.0 *
--report="&reportpath.\sl0l-sdtm.xlsx "

A

A
A

A

Il

Example 2. ADaM Validation

X
java -jar "&jarpath.\&jarfile."
--standard=adam "
--standard.version=1.0
--source.sdtm="&sdtmpath." *
--source.adam="g&adampath." *
—cdisc.ct.sdtm.version=2017-12-22 *
—cdisc.ct.adam.version=2017-09-29 »
--meddra.version=19.0 *
--report="&reportpath.\sl0l-adam.x1lsx”

A

A

Il

Example 3. ADaM Validation (ADSL and ADAE only)

X
java -jar "&jarpath.\&jarfile."
--standard=adam "

--standard.version=1.0
--source.adam="¢&adampath.\ADSL.xpt; &adampath.\ADAE.xpt" *

A

A
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--cdisc.ct.sdtm.version=2017-12-22 *
--cdisc.ct.adam.version=2017-09-29 ~»
--report="&reportpath.\sl0l-adam-adae.xlsx"

Il

Example 4. Define Template Generator

X
java -jar "&jarpath.\&jarfile."
--standard=sdtm "
--standard.version=3.2
--source.sdtm="&sdtmpath."
--meddra.version=19.0
--cdisc.ct.sdtm.version=2017-12-22 *
--output.format=define-excel *
--output="g&reportpath.\sdtm define template.xlsx"

A

A

A

Il

Example 5. Define.XML Generator

X
java -jar "&jarpath.\&jarfile."
--standard=sdtm "
--standard.version=3.2
--source="greportpath.\sdtm define template.xlsx"
--output="g&reportpath.\sdtm define.xml" *

A

A

A

Il

Example 6. Define.XML Validation

b
java -jar "&jarpath.\&jarfile."
-—-config="&configpath\Define.xml"
--standard=sdtm "
--source.define="&sdmtdefine.\define.xml"
--cdisc.ct.sdtm.version=2017-12-22 *
—--report="g&reportpath.\define validation report.xlsx"

A

A

A

I

VALIDATION RETUN CODES

When the report parameter is provided, CLI will perform high level analysis of the validation report and
returns a code for the highest severity found on the Issue Summary sheet. For example, if there are many
issues reported and one of them is a Reject, the CLI return code will be 1. A list of possible return codes
are shown in Table 2. The return code is stored in $errorlevel% and $Sresult for Windows and Mac
systems, respectively. Example 7 shows a batch program that calls the CLI to perform SDTM validation
and outputs the return code to a file. Saving the return code to a file may be useful for signaling the start
of additional workflows. For example, if the SDTM CLI return code is greater than two, ADaM validation
can automatically start.
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Return Code Severity Value
1 Reject

2 Error

3 Warning

4 Notice

5 N/A

Table 2. List of CLI Return Codes

Example 7. Calling CLI from Windows batch file and output CLI return code to file

java -jar %jar%$ --standard=sdtm --standard.version=3.2 --
source.sdtm=%sdtmdata% --cdisc.ct.sdtm.version=2017-12-22 --
meddra.version=19.0 --report=%valreport$%

@echo errorlevel=%errorlevel% >> "C:\slOl-sdtm-error.txt"

ENTERPRISE USE

Enterprise users can call the CLI to perform tasks over an Enterprise server by providing additional
parameters. Enterprise-specific parameters are listed in Table 3. The additional parameters can be added
to existing code or specified in the configuration file, pinnacle21.conf. The pinnacle21.conf file
should be saved in the same file location as p21-client-{version}.jar and look similar to the
sample configuration file presented in Figure 1. It is recommended to place static parameters that deal
with connectivity or environment in the configuration file to keep command line clean and relevant only to
the project. After the configuration file is set-up for use, the CLI will automatically pull the specified
parameters from the file and run in “Enterprise mode”. All validations are stored on the Enterprise server
and access to validation results can be controlled from the CLI using the group parameter such that all
users assigned to the specified group will be able to see the validations completed using the CLI.

Example 8 is an SDTM validation modified to run on an Enterprise server and pulls Enterprise parameters
from pinnacle21.conf. Example 9 is an ADaM validation that specifies the Enterprise parameters in
the command line instead of the configuration file. Transitioning from Community CLI to Enterprise CLI is
easy and the resulting enterprise validation report includes more information as depicted in Figure 2.

Enterprise Valid Conf. L.
Parameter Values Req Default file Description
Enterprise Connection Parameters

X X API Key from the
enterprise server API
--api.key API Key Keys admin page
--web.host URL X X Enterprise server URL
enterprise_cli X User group. Should be
created on the server
--group prior to using CLI
Enterprise Project Setup Parameters
--project Project enterprise_cli X Name of the project.
Name CLI creates new
project if does not
exists.
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Enterprise Valid Conf. L
Parameter Values Req Default file Description
--study Study enterprise_cli X Name of the study. CLI

Name creates new study if
does not exists.
-filter ALL ALL X Config filter to apply.
PMDA
FDA
--datapackage Data Name of the
package datapackage. CLI
name creates new data
package if does not
exists.
--create.always Yes Yes X Create project and/or
No study based on
command line --
project/--study
parameters if does not
exist. Default is Yes.
To prevent auto create
set this parameter to
No.

Table 3. List of Enterprise-Specific CLI Parameters

| pinnacle21 - Notepad =[BT

File Edit Format View Help

# this is local client config file loaded from the file system
web.host="https://{your company}.pinnacle2l.net”
api.key="{Enterprise server key}"

# user group. Default enterprise_cli
group=enterprise_cli

# create.always yes/no parameter controls CLI behavior when provide --project

# or --study does not exists. If create.always=yes then CLI will create project/study
# otherwise if project/study does not exist CLI will fail. Default value is yes
create.always=yes

Figure 1. Sample configuration file, pinnacle21.conf



How to Automate Validation with Pinnacle 21 Command Line Interface and SAS®, continued

Example 8. SDTM Validation with Enterprise parameters from pinnacle21.conf

X

java -jar "&jarpath.\&jarfile.™ 7
--standard=sdtm *
--standard.version=3.2 *
-—-source.sdtm="aspera://&sdtmpath."™ *
--source.define="&sdmtdefine." *
--meddra.version=19.0 *

--report="&reportpath.\sl0l-sdtm.xlsx "

Il

Example 9. ADaM Validation with Enterprise parameters from the command line

X

java -jar "&jarpath.\&jarfile.™ *
--study="s101" ~
--group="s101 team" ~
--web.host="&url." *
--api.key="&apikey."
--standard=adam "
--standard.version=1.0 *
--source.sdtm="aspera://&sdtmpath."™ *
--source.adam="aspera://&adampath."™ *
--meddra.version=19.0 *
--report="&reportpath.\sl0l-adam.x1lsx"

A

Il

Enterprise CLI: SDTM
Dashboard | Analysis Support | Datasets | Issues | History | = More Reports

4l Data Fitness Scorecard

Overall Score SDTM Compliance

Controlled Terminology

5 8 Regulatory Conformance

%H

Metadata
Data Quality
182 Issues (N
0.4% Issue Rate Analysis Support

Severe Issues
Severity  Dataset Rule Issue

Error IE SD1077 FDA Expected variable EPOCH not found

Error AE SD0091 AEOUT is not 'FATAL', when AESDTH="Y"

Error MH SD1114C  Case for MHBODSYS is in incorrect case

Error MH SD0008C  Value for MHDECOD is in incorrect case

Error PR SD0035 Missing value for PRDOSU, when PRDOSE, PRDOSTXT or PRDOSTOT is provided
Error AE SD1132 AESER is not 'Y"

Error bv SD1077 FDA Expected variable EPOCH not found

Error MH SD1114 Value for MHBODSYS not found in MedDRA dictionary

Error AE SD0080 AE start date is after the latest Disposition date

Error AE SD0009 No qualifiers set to 'Y", when AE is Serious

Figure 2. Enterprise Validation Generated with CLI

@ 3 custom Datasets

@ 17 suppqual Datasets

Y Filter: All » (7 Export Report

iE  Standards & Dictionaries

Standard Used
& 458 suvjects SDTM-IG 3.2
Dictionaries Used
& 49 Total Datasets MedDRA 16.0, SNOMED 2017-03-01, UNII 2017-

04-28, NDF-RT 2017-06-14, SDTM-CT 2017-06-30

2 317648 1ot Aecorus

= Important Links
Trial Summary
Create Define.xml
Reviewer's Guide
Annotated CRF

Impacted Analyses

Anatysis
Exposure Analysis Panel

JMP Clinical Treatment Emergent AE Summary
JReview Heart Rate Baseline vs Max Value Scatter Plot

JReview Heart Rate Baseline vs Min Value Scatter Plot
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ERROR HANDLING AND DEBUGGING

Running Pinnacle 21 with the CLI is simple but if something doesn’t work as expected, a list of error
codes are provided in Table 3 to help you debug and identify any issues. After using the CLlI, a log file,
p2l-client-{version}.logis created. Check this log file for errors and modify the program
accordingly. You can also write additional information to the log by adding the statement, -
Dcli.log.level=debug such that the first line of the command line code is:

java -Dcli.log.level=debug -jar..

Error Code Description
—CLI.1.1 [Error code: 255] General CLI exception
—CLI.2.2 [Error code: 234] Standard is unknown

—CLI.2.3 [Error code: 233] Format type is unknown

—CLI.2.4 [Error code: 232] Terminology value is invalid or not defined
—CLI.2.5 [Error code: 231] Dictionary value is invalid or not defined
—CLI.2.6 [Error code: 230] Enterprise data type is unknown
—CLI.2.7 [Error code: 229] Release version is undefined

—CLI.2.8 [Error code: 228] Parsing failed. Cannot read data source
—CLI.2.9 [Error code: 227] Provided Value is unknown

—CLI.2.10 [Error code: 210] Request type value is unknown
—CLI.3.1 [Error code: 225] Request type cannot be determined
—CLI.3.2 [Error code: 224] Failed to copy data source

—CLI.3.3 [Error code: 223] Define file does not exists

—CLI.3.4 [Error code: 222] Failed to copy define XML

—CLI.3.5 [Error code: 221] Failed parsing input argument list
—CLI.3.6 [Error code: 220] File or folder does not exists

—CLI.3.7 [Error code: 219] Client call failed

—CLI.3.8 [Error code: 218] Failed creating output directory
—CLI.3.9 [Error code: 217] Control terminology does not exists

—CLI.3.10 [Error code: 202] Failed creating output file

—CLL.3.11 [Error code: 201] Failed processing client task

—CLI.3.12 [Error code: 200] Failed core process.

File is opened and cannot be written to. Please close the
—CLI.3.13 [Error code: 199] file and restart process

—CLI.3.14 [Error code: 198] Config for integration library is not found

—CLI.3.15 [Error code: 197] Enterprise user group is not found

System setup and configuration error. Please update
—CLI.3.16 [Error code: 196] your system

—CLI.3.17 [Error code: 195] System installation qualification error

—CLI.4.1 [Error code: 215] Data source is invalid
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Error Code Description

—CLI.4.2 [Error code: 214] Argument parsing results must be provided
—CLI.4.3 [Error code: 213] Standard type is required

—CLl.4.4 [Error code: 212] Data source is required

—CLI.4.5 [Error code: 211] Standard version is required
—CLI.4.6 [Error code: 210] Report file is required
—CLI.4.7 [Error code: 209] Config is required

Table 3. List of CLI Error Codes

CONCLUSION

The Pinnacle 21 Command Line Interface (CLI) is a handy tool for both Community and Enterprise users
and supports all aspects of validation: data validation, define excel template generator, define.xml
generator, define validation, and data converter. Current users of Community CLI can easily transition to
Enterprise CLI with very few programming changes because the syntax is virtually the same. Because it
can be called directly from SAS, the CLI saves precious programming time and can support the
automation of an organization’s specific workflows. Regardless of how you use the CLI at your
organization, the new CLI is an essential tool for SAS programmers that want to automate validation of
CDISC data.
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